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ALPHA OMEGA PRODUCTS 

LIMITED WARRANTY 
 

Alpha Omega Engineering LTD., warrants that their Products will be in good working order 
for a period of one year* from the date of shipment from Alpha Omega Engineering.  If the 
Product is not in good working order, the Purchaser shall notify Alpha Omega Engineering 
or it’s authorized representative promptly. 

If the Product fails within the warranty period, Alpha Omega Engineering will provide parts 
and labor at no additional cost, to repair or to replace, at its sole option, the necessary 
components of the Product.  The repair or replacement parts will be furnished on an 
exchange basis, and will be either reconditioned or new.  If the Product is not in good 
working order, the Purchaser’s sole remedy shall be repair or replacement as set forth 
above. 

This limited warranty does not include service to repair damage resulting from accident, 
disaster, misuse, or modifications by parties other than Alpha Omega Engineering or its 
authorized representatives unless granted by Alpha Omega Engineering.  The postage, 
insurance, and shipping costs incurred in presenting or shipping the Product or 
components for service are the responsibility of the Purchaser. 

THE PURCHASER IS RESPONSIBLE FOR DETERMINING WHETHER THE PRODUCT 
PURCHASED MEETS THE PURCHASER’S NEEDS.  THE PURCHASER IS 
RESPONSIBLE FOR THE USE OF THE PRODUCT AND FOR THE RESULTS OF ITS 
USE.  ALPHA OMEGA ENGINEERING SELLS THEIR PRODUCTS “AS IS” WITHOUT 
WARRANTY OF ANY KIND, INCLUDING ANY EXPRESS OR IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH THE 
EXCEPTION OF THE EXPRESS TWO YEAR LIMITED WARRANTY MENTIONED 
ABOVE.  IN NO EVENT SHALL ALPHA OMEGA ENGINEERING CO LTD., BE LIABLE 
FOR ANY LOSS, INCONVENIENCE, OR DAMAGES, WHETHER DIRECT, INCIDENTAL 
OR CONSEQUENTIAL, ARISING OUT OF THE USE OF, OR INABILITY OF USE, THE 
PRODUCT. 

THE PURCHASER ASSUMES THE RISK AS TO THE QUALITY AND PERFORMANCE 
OF THE PRODUCT.  SHOULD THE PRODUCT PURCHASED PROVE TO BE 
DEFECTIVE, THE PURCHASER, AND NOT ALPHA OMEGA ENGINEERING, SHALL 
ASSUME THE ENTIRE COST OF ALL NECESSARY REPAIRS, SERVICING, OR 
CORRECTIONS, EXCEPT AS STATED ABOVE.  ALPHA OMEGA ENGINEERING DOES 
NOT WARRANT THAT THE PRODUCTS WILL OPERATE WITHOUT DEFECTS. 

 
SOFTWARE LICENSE 
ALPHA OMEGA ENGINEERING LICENSES THE SOFTWARE PROVIDED WITH THE 
PRODUCT (EXCLUDING THE WINDOWS SOFTWARE) THAT IS CONTAINED IN READ 
ONLY MEMORY (ROM) AND ON DISK, TO THE PURCHASER.  THE PURCHASE MAY 
NOT COPY THE SOFTWARE THAT IS IN ROM.  THE PURCHASER MAY COPY THE 
SOFTWARE THAT IS ON DISK FOR BACKUP PURPOSES ONLY. 

*Note for those who purchased a computer from Alpha Omega Engineering: The computer 
and its software have their own warranty that is not included in the one-year warranty 
stated above. 
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1. INTRODUCTION 
1.1 General Description  

Alpha EPS is a modular multi-electrode micromanipulator that is used 

to manipulate extra-cellular 
microelectrodes.  The basic 
system can independently control the vertical position 

of 4 electrodes in a resolution of 1m.  The system can be upgraded in 
multiples of 4 to enable independent control of the vertical position of 
up to 32 electrodes.   

The system is composed of: 

1. Printed Circuit Board (Control Board) 
This board is plugged into a PC.  Each card can control 8 channels 
(electrodes).  To control more than 8 electrodes, it is possible to 
cascade several cards in the same PC. 

2. Electrode Driver Box 
The driver box includes the motors; the feedback elements needed to 
control the movements of the electrode, and two D-type connectors.  
One connector (25-pin) is used to connect the Driver Box to the 
Control Board, and the second (9-pin) connector is use to connect the 
analog signals samples by the electrodes to the signal conditioning 
system.  It is situated near the animal’s head.  Each box can control 4 
channels (electrodes).  It is possible to cascade several boxes to 
control up to 32 channels. 

3. Control Cable 
This 6-meter long cable connects the control card, which is plugged 
into the PC to the electrode driver box (through the 25-pin D-type). 

4. Power Supply Cable 
This cable connects to the control board, in the rear side of the board. 

5. Software Package 
A user-friendly software package that runs under Windows 
98/2000/NT/XP is provided.  The software can be set to independently 
control any electrode.  There is no limit, theoretically, to the number of 
electrodes that can be controlled by this software. 
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2. INSTALLATION GUIDE 
2.1 Overview  

Alpha EPS is modular and can be purchased in several forms.  The 
hardware components that are included in each configuration are 
listed in Table 2-1. 

Table 2-1 Hardware Components 

# of Electrodes 
(channels) 

# of Control 
Boards 

# of Electrode 
Driver Boxes 

# of Control 
Cables 

4 1 1 1 

8 1 2 2 

12 2 3 3 

16 2 4 4 

20 3 5 5 

24 3 6 6 

28 4 7 7 

32 4 8 8 

 

2.2 Hardware Installation  
2.2.1 Minimal PC Requirements 

Note:  The Control Board should be installed in a Pentium 2 PC or higher that 
runs Windows 98/2000/NT/XP (depending on the number of cards used, 
contact us for details). 

 

 PC power supply of 300 Watt that has the voltages: -12V, +3.3V, 
+5V, and +12V.  

 One Board (PCI) bus slot per 8 channels.  

 Display (recommended resolution of 800 x 600 or higher). 

 Mouse. 

 CD-ROM driver for the installation of the EPS software. 

2.2.2 Unpacking 
Unpack the Control Board(s).  Inspect the board(s) carefully for any 
transportation damage.  Contact your dealer if any damage was 
caused.  For future reference, write down the serial number of the 
board(s).  The number is printed on the board near the center of the 
bottom edge. 
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Control Board(s) serial number(s)    

2.2.3 Installing the Control Board in the PC 
1. The Alpha EPS should be installed in a suitable computer with safety 

approval. 

2. A technician, familiar with the PC should perform the installation. 

3. The person responsible for the Alpha EPS installation should only 
access the areas designated for users. 

4. Turn off the PC and all peripheral devices attached to it.  Unplug all 
power cords from the wall outlet.  

5. Remove the PC top cover (refer to your PC user's manual for 
instructions).  

6. Select one of the available PCI expansion slots. 

7. Remove the cover plate mounted on the PC rear panel of the selected 
slot.  

8. Hold the Logic Board by the top edge.  Align the board with the card 
support and the card slot, located on the main board.  Insert the board 
in the card guide slots until it reaches the bottom of the expansion slot.  
Press the board evenly and gently, until it is firmly lodged in the 
expansion slot. Carefully guide the two 26-pin High-Density twisted 
cables connectors through the cutout window in the rear panel of the 
PC.  

9. Align the hole in the card-retaining bracket on the Logic Board with the 
screw-hole in the rear panel of the PC and firmly close the screw from 
the card slot cover (that was removed earlier). 

10. Connect the Power Supply 4-pin male connector to the 4-pin female 
connector located in the rear side of the Alpha PCI EPS board. 
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11.  For users with more than 8 channels: repeat steps 7-10 for the 
second Logic Board. 

12.  Replace the PC top cover. 

 

2.2.4 Installing the Joystick and Sound-Blaster Card 
A joystick allowing the user to manipulate the electrodes from a 
remote location, e.g., near the animal can control the Alpha EPS.  If 
the sound blaster card, along with the joystick and the speakers, are 
not installed, please install them following the installation instructions 
of the sound blaster. 
 

Note: the joystick, sound blaster, and speakers are not supplied with the Alpha 
EPS package. 

 

2.2.5 Locating and Connecting the PC to the Electrode Driver 
Box 

You may place both parts of the system  (PC and electrode driver box) 
in their final location, or in a temporary location, ensuring that the 
distance between the two sub-systems is less than 6m, to allow 
physical connection.  When using one Alpha EPS box (4 motors), 
connect the 26-pin cable to the connector that resides down on the 
control board on one side.  At the other end of the cable there are a 
female 25-pin D-type connector that should be connected to the male 
25-pin D-type connector of the Alpha EPS box motors.  
 If using two Alpha EPS boxes (8 motors), connect the same second 
26-pin cable to the connector that resides up on the control board on 
one side.  At the other end of the cable there are a female 25-pin D-
type connector that should be connected to the male 25-pin D-type 
connector of the second Alpha EPS box motors.  
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2.3 Mechanical Installation 
2.3.1 Driver Box Installation 

It is possible to place the electrode driver box very close to the animal, 
since the box dimensions are small.  To secure the box above the 
animal’s head, you can use the round hook on the side of the box.  
Insert the hook inside a round rod and tighten it with an Allen screw. 

2.3.2 Flexible Shaft Connection 
Please refer to Appendix A for details about Flexible Shaft connection. 

2.3.3 Ready to Go 

 Reconnect all power cords. 

 Turn on the PC. 

 The PC detects any PCI Control Board that has been added.  
A “New Hardware Found” message will be displayed and the 
PC will look for a matching driver.  The computer does this 
procedure automatically, however should any problems occur, 
the driver may be found at the installation CD (Drivers/ Win98 
(2000 or NT)/  ‘Alpha_EPS_GII.inf’).  

 Refer to "Software Installation Guide" for software installation. 

  

2.4 Software Installation 
2.4.1 Overview 

The Alpha EPS software is provided on a CD.   Either as a standalone 
system or as part of  the AlphaLab Pro system.   Usually when 
purchased as part of the AlphaLab Pro, the software will be already 
installed.   The description below applies to installing the software form 
the standalone EPS GII system  

 

2.4.2 Installation 
 

1. Insert installation CD into the CD-ROM drive.  Setup should 
commence automatically.  If setup did not start automatically, 
click the letter of the CD-ROM drive to explore the CD and then 
click the Setup.exe icon to run setup. 

2. The setup program will guide you through the installation 
procedure. 
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2.4.3 Alpha EPS Setup 
When running the Setup program, the Alpha EPS setup displays the 
following dialog box on the screen. 

 

Figure 2-2: Alpha EPS Setup Dialog Box 

 
 
Install: 

 

Click the Next button to start the process.  During installation you can specify a 
different path (location) to which the Alpha EPS program will be installed. 

 

Restart the computer: 
 

After the completion of the installation process the computer must be restarted 
before the software can be operated.  

 

Figure 2-3: Computer Restart 

 

 
Click ‘Yes’ to restart the installation or ‘No’ to restart later. 
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2.4.4 Setting up the Driver 
After software is installed and computer is restarted, the right driver for 
the PCI board should be selected as follows: 

1. Go to Windows Device Manager list, and find the device listed 
under Jungo. 

2. Right click on the device and click Properties. 

3. Select Driver Tab and Update Driver.   

4. Select the driver “Alpha EPS GII.inf” from the driver folder under 
the EPS GII setup library. 

  

2.4.5 Setting up the BIOS (On certain computers only) 
Some Pentium 4 or newer computers may experience “Blue Screen” 
errors or “System Lockup” when the EPS GII is started and used.  In 
this case check the system BIOS of the computer by rebooting the 
system and hitting the BIOS entry key (i.e. : Delete of F10 key) at the 
beginning of the system restart. 

 

Shut off the “PCI Serr Generation” item, save the BIOS, and restart the 
computer. 
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3. OPERATING THE EPS 
3.1   Initializing the Alpha EPS 

Note:  Once the Alpha EPS hardware and software have been installed, the 
next step is to enter the program and set the parameters.  
 

Double-click on the Alpha EPS icon to start the program: 

Figure 3-1: Alpha EPS Icon 

 
 

Or choose Programs → Alpha Omega Applications → Alpha EPS Application 
from the Windows Start menu.   

The Alpha EPS program is started. 

If you are running the system for the first time, or if you need to 
reconfigure the setup or change the system setting, click the Options 
menu and then click Initialize.  

The Alpha EPS Initialization dialog box appears.  Click the Refresh 
button and the dialog will display all connected boards (Figure 3-2).  

 

Figure 3-2 Alpha EPS Hardware Initialization Dialog Box  

 
 

Check the boxes of the electrodes that will be used.   

In order to change the properties of an electrode(s) highlight it and click the 
Properties button. 

Note: You can use the “Shift” and the “Ctrl” buttons to choose the properties of 
more that one Electrode. 
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The Electrode Properties dialog will appear: 

Figure 3-3: Electrode Properties dialog 

  

 
 

Editable fields: 
 
Enable checkbox – if checked the electrode will be enabled. 
 
Name – change the name of the electrode. 
 
Slack - specify the number of micrometers the electrode will move (when the 
direction of the movement changes) to close the slack generated in the last (opposite 
direction) movement. 
 
Range - the maximum range of the device is 40 mm, but the user can limit the range 
by specifying the desired range in the field. 
  
Group - Specify the name of the group (window) in which the electrode will be 
grouped.   

It is possible to group electrodes into different groups.  An electrode can be grouped 
in any preferred order.  Electrodes from different boards can be grouped together; 
electrodes from the same board can be grouped in different groups. 
  

Note: All the Setup parameters can be altered from within the Alpha EPS program. 
Once the electrode properties  have been edited click OK.  The Initialize dialog will 
appear and include the new property settings.   

 

To finalize initialize process and start the Alpha EPS program click the OK button 
on the Initialize dialog.   

When the Alpha EPS starts the program asks whether to reset the electrodes to 
zero position:   
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Figure 3-4: Electrodes reset dialog 

 
 

Click ‘Yes’ to reset all electrodes to zero position.  Click No to open the EPS 
program and display the current electrode position that was previously saved.   

If the EPS detects hardware changes the following message appears: 
 

Figure 3-5: Hardware Changes Detected 

 

Click Yes to Initialize EPS parameters or No to continue using current 
parameters. 

3.2 Alpha EPS Windows Application 
After initialization is finalized the Alpha EPS program starts and the 
following window appears: 

Figure 3-6: Alpha EPS Main Screen 
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3.3 Operating the Motors 
The user can advance the motors using windows buttons and controls, a mouse, a 
keyboard or a joystick.  Description of the control is below. 
 

3.3.1 Tools & Commands for Operating the Alpha EPS 

The following buttons are displayed on the tool bar. 

 

Figure 3-7: The Alpha EPS Toolbar 

  

Following is a description of the various functions of the different buttons and 
fields. 

 
 

Advance all the electrodes in the highlight group that are in the ON position 
upwards by the small step value.  The small step value is displayed on the tool 
bar and the user can change the value of this step. 

Advance all the electrodes in the highlight group that are in the ON position 
downwards by the small step value.  The small step value is displayed on the 
tool bar and the user can change the value of this step. 

 
Advance all the electrodes in the highlight group that are in the ON position 
upwards by the large step value.  The large step value is displayed on the tool 
bar and the user can change the value of this step. 

 
Advance all the electrodes in the highlight group that are in the ON position 
downwards by the large step value. The large step value is displayed on the 
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tool bar and the user can change the value of this step. 

 

Stop the movement of all the electrodes in a group any time. While the 
electrodes are moving, this button is activated and its color changes to red.  

 
  

This box allows specifying the size of the Large Step. 
 
 
This box allows specifying the size of the Small Step. 
 
 

 

 

Electrode speed bar - Adjust the speed of all the electrodes in the highlight group that 
are in the ON position (highest speed is approximately 400 micron per second). 

 

Stop the movement of ALL electrodes at any time.  While electrodes are 
moving, this button is activated and its color changes to red. Shortcut: ESC  

! See Technical Reference for more detailed information concerning speed and 
accuracy of the Alpha EPS system. 

 

 

 

 

 

 

 

 

 

 

 

 

In addition to the buttons on the tool bar, the user can manipulate each electrode 
separately.  Following are the buttons and fields the user can utilize. 

 
Figure 3-8: Individual Electrode Manipulation 

 

 

 

 

On /Off  Field 
Target Field 
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On/Off:  When this field is in the ‘Off’ position none of the buttons affect this 

electrode, including the advance large or the advance small buttons. 
 
Target:  Sets the target depth of the electrode.  The next time the electrode 

advances/ retracts it will move to the target specified in this field. 
 
Offset Field: The user can enter an offset value (positive or negative).  Pressing 

Enter after writing the value will force the electrode to move in an 
offset of the written value. 

 
Act as the buttons in the Alpha EPS toolbar but work individually on 
the specific electrode.                        

 
Ruler:   The ruler indicates the position of the electrode. 
 
Speed Bar: Controls the motion speed of the electrode (similar to the toolbar).  

 

In addition to the above controls, the user can perform the following operations from 
the Menu. 
 
If, for any reason, the Alpha EPS was shut down while the motors were moving, the 
next time the program is opened the following dialog appears: 
 

Figure 3-9: EPS begin initialization dialog 

Advance Large Step Up 
Shift+PgUp 

Advance Small Step Up 
PgUp 

Stop electrode 

Advance Large Step 
Down Shift+PgDown 

Offset Field 

 Ruler 

Electrode Speed bar 

Movement 
Buttons 
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Press the appropriate button to continue working. 
 
 

3.3.2 Alpha EPS Menu Options 
 

File Menu:  
 
Save As: Opens a dialog for saving the current view. 
 
Open: Opens a dialog for opening an existed file. Shortcut: CTRL+O. 
Close: Closes the Active group. Shortcut: CTRL+F4. 

Save Electrode Info:  Opens a dialog for saving the current electrodes 
positions into a text file. 

 

Example of a saved file: 
 
Friday, 06/06/03 10:13:47.  Alpha-Omega Engineering 

Group Name Relative Pos(mm) Absolute 
Pos(mm) 

Group1 Electrode1 4.808 4.808 

Group1  Electrode 2 7.900 7.900 

Group2 Electrode3 2.541 15.541 

Group3  Electrode4 22.610 22.610 
 
Restore Closed Groups: Opens a window to choose restoring some or all the 

closed groups. 
 
Restore all Closed Groups: Restoring all the closed groups. 
 
Exit: Exits the EPS application. Shortcut: ALT+F4. 

 
 
View Menu: 
 
Toolbar: Show or hide the toolbar. 
Status Bar: Show or hide the Status Bar. 
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Tools Menu: 
 
Set Zero  Clicking this field does not affect the position of the 

electrode but it changes the scaling of the ruler of the active 
electrode. The current position display will be zero. 
 

Unzero  Clicking “Unzero” will recall the absolute scaling of the 
specific electrode. 
 

Stop Electrode Stops the active electrodes. 
Stop Group 
  

Stops the currently moving electrodes in the active group 
(similar to the Stop button at the toolbar). 
   

Stop All Electrodes Stops all moving electrode (similar to the Stop All button at 
the toolbar).  
  

Reset Group Reset all electrodes of a group (that are On) to the zero 
position. 
 

Reset All Reset all of the electrodes that are On to the zero position. 
 

Retract Opens the Retract dialog for specifying a point to retract all 
electrodes in the active group to. 
 

Change Position  Change the current position of a specific active motor 
without moving the motor. 
 

Calibrate  Opens the calibration dialog box. 
 
 

Figure 3-10: Calibrate Dialog Box 

 
 

The Calibrate Dialog window enables to calibrate the A/D that is used to reset the 
positions of the electrodes to zero.  The user is advised not to change the calibration 
without consulting Alpha Omega technical support, since the Alpha EPS might be 
damaged. 
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Remote Joystick Opens the Joystick Control window used for controling the 
Alpha EPS by using a joystick. 

 
Figure 3-11: Joystick control Dialog Box 

 
 
 
 
 
 
 
 
 
 
 

Note: before using the joystick control option, the joystick needs to be calibrated at 
the Windows Control Panel.  To calibrate a joystick click the Windows Start button 
and then select Settings, Control Panel.  Click on the Game Controllers icon.  In the 
dialog box that appears select the joystick that is used and click the properties 
button.  Follow the instructions that appear on the screen to proceed with the 
calibration process.     

 

Controlling the Alpha EPS engines using a joystick 

The joystick allows the user to select and maneuver an electrode up and down.  To 
select the appropriate electrode move the joystick to the right.  When the cursor is 
placed on the right rectangle (see figure 3-11) press Button1 on the joystick.  If the 
speakers are connected a sound is generated stating the name of the electrode that 
was reached.  To select an electrode with a lower number then the one that is 
currently selected move the cursor to the left rectangle and follow the same 
procedure.   

In order to maneuver the electrode upward, move the cursor to the upper rectangle 
and press Button 1.  To move the electrode downward, move the cursor to the 
bottom rectangle and press Button 1.  The maximum movement size is defined by 
the small step that is set in the Alpha EPS main interface.  To stop the electrode 
movement (in case the maximum step size has not been reached yet) press Button 
2. 

Note:  Buttons 3 and 4 are saved for future use and are currently not functional.   

Options Menu: 
 

Initialize:  Open the initialization dialog.   

See section 3.1 (Initializing The Alpha EPS) for more details. 

Run Script:  Opens the Run Script dialog. 
This mode enables the user to manipulate the electrodes according  to 
pre-set instructions determined in an external script file.   

All the movements and speeds of the different electrodes are recorded in the output 
file. The output file is generated if the “Print results to file” box is checked. 

  

Figure 3-12: Run Script dialog 
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The script is simply a text file that contains a series of commands for the Alpha EPS.  
 
A script file can be easily created using any word processing software  
(in the above example Notepad is used).   
The syntax of the commands (input.txt) is as follows: 
 

 RESET #board #motor 
 MOVE #board #motor offset times 
 GOTO #board #motor position 
 SPEED #board #motor slider_value 
 DELAY d_value 
 MESSAGE mes_string 
 RENAME new_name 

 
Notes: 

 For RESET, MOVE, GOTO and SPEED: If #board value is –1 or #motor 
value is –1, it’s mean that this command is for all the boards or for all 
the motors. 

 For DELAY: d_value unit is second 
 For SPEED: ‘slider_value’ values are between 0-400. 
 For RENAME: rename the trace_ou.dat file to new_name.dat file. If the 

value is –1 then add next number to trace_ou#.dat 
 
 
 
 
 
 
 
 
 
 
 

See this example to understand these commands:  
 
 
Command line Explanation 

RESET 1 -1 Reset, from board 1, all electrodes  (-1 
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indicates all electrodes are to be reset.  If a 
specific electrode needs to be reset write the 
number of the electrode instead). 
 

MOVE 1 -1 10 10  Move, from board 1, all electrodes, 10mm, 10 
times. 
  

GOTO 2 3 1  Reposition, from board 2, electrode #3, to 
1mm. 

DELAY 25 Make a delay of 25 seconds 
 

 

To open a script file use, the browse button  to locate it. 
Select your favorite text editor (for example Notepad) 
To edit the script file click the Edit button next to the script file field. 
 
It is possible to log the results of the Alpha EPS movements.  To use this feature 
check the “Print results to file” checkbox. 
 
The output log file may be edited or erased by pressing the appropriate buttons next 
to the Output text file field. 

 

 

Script Line Examples: 
 

 
*Move: Use: Move brd elc ofs No. 

Brd: is the board Number 
Elc: is electrode Number 
Ofs: is the movement requested in mm (positive value= down , 
negative value=up) 
No.: Number of times this movement will be performed 

 

Previewing the script file results  

The Preview button enables the user to view what would be the results of running 
the script file without actually moving the motors.  Preview is done on an Alpha EPS 
look alike interface. 

 

Command Script Line Movement 
Move* move 1 3 -0.025 3 

 
advance the 3rd electrode in control board 
#1 0.025mm up, 3 times 

 move 1 -1 10 2 advance all electrodes in control board #1 
10mm down, 2 times 

Goto goto 1 2 18 advance the 2nd electrode in control board 
#1 to location 18mm 

 goto 1 -1 23 advance all the electrodes in control board 
1 to location 23mm 

Delay delay 18 make a delay of 18 seconds 
Reset reset –1 –1 reset all the electrodes in all boards to zero 

position 
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To run the script file click the Begin button.     

 
 
Windows Menu: 
 
Cascade: 

Arranges all opened windows (groups) in a cascaded (overlapping) order. 

Tile Vertically: 
Arrange all opened windows (groups) in a vertically tiled order. 

Tile Horizontally: 
  Arrange all opened windows (groups) in a horizontally tiled order. 

Arrange Icons: 
 Arrange all Minimized windows (groups) at the bottom of the main 
Alpha EPS window. 

 

Help Menu: 
Figure 3-13: Help Dialog Box 

 

Index: Contains a table of contents that provides access to a number of Alpha EPS 
on-line help subjects. 
Using Help: Windows Help subjects. 
 
Context Help: Dragging the mouse to a location on the screen showing the ‘?’ 

symbol will cause the related on-line help subject  (if available) to 
appears in a window on the screen. 

About: display software version and manufacturer information.   
 

 

 

 

 

 

 

3.3.3 EPS Shortcut Keys 

CTRL+O:  File Open: Open an existed file. 

CTRL+F4:  File Close: Closes the Active group. 

ALT+F4:  File Exit. Exits the EPS application. 

ESC:   Stops the current movement for all the electrodes.  
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PgUp: Advances the current electrode one small step 
upwards. 

PgDown: Advances the current electrode one small step 
downwards. 

Shift+PgUp: Advances the current electrode one large step 
upwards. 

Shift+PgDown: Advances the current electrode one large step 
downwards. 

CTRL+F6:  Moves to the next group. 

Shift+CTRL+F6: Moves to the previous group. 

 

3.4 Using the EPS for Micro-Injection 
With a special mechanical adaptation, it is possible to mount a syringe onto one of  
the EPS box motors and use the EPS software to control the injection of fluids into 
the brain.   To enable the MicroInjection function for a the first motor on the first 
board, add the following section to the EPS.INI file.   

[Board1Electrode1] 

MicroInjection=1 

MIVolume=xxx 

MIUnits=yyy 

MIRange=zzz 

If you are using the Client Server feature, these updates must be done on the server, 
and then retrieved by the clinet by using the “Get Server Settings” option.   

 

 

 

Below is an explanation of the meaning of each one of the lines added: 

MicroInjectio  =>  0 = disabled,  1 = Enabled 

MIVolume = Total Volume of the syringe used 

MIUnits = Units used in the syringe, for example ml, uL, CC etc.   

MIRange = Total movemet range in mm of the syringe needed to inject its whole 
contents. 

Below is an example of a syringe and the parameters needed for it. 
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[Board1Electrode1] 

MicroInjection=1 

MIVolume=5 

MIUnits=ml 

MIRange=44   

Adding the section above will show a new button in the EPS interface as shown 
below for the selected electrode (or motor) labeled MI for Micro Injection.   See figure 
below: 

 

Micro  Injection Button 

When this button is pressed it opens a new dialog that shows the amount injected.  
See fugure below. 
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This Dialog can be moved and positioned any where on the screen.   It will show the 
total amonnt injected, and it also allows the user to specify how much to inject in the 
Step field.    The main EPS interface will still display the movement in millimeters as 
before.   

 

3.5 Technical Reference 
3.5.1 Shut Off 

This is a TTL output signal that denotes a moving electrode.  This 
output is usually high (+5V), but when any electrode is moved, it is 
changed to low and remains low till the moving electrode stops.  This 
signal is useful when no recording is required when the electrodes are 
moved.  It can be used to prevent recording the analog signals while 
any of the electrodes is moving.  

The shutoff connector has 3 pins.  The outer pins are Digital Grounds, 
and the inner pin is the Shutoff signal (see the diagram below). 

 

 
 
 

 

 
Note: At the rear panel of the MCP+ (Alpha Omega’s Signal Conditioning System) a 

SHUTOFF control input is supplied. When this input is low, all analog inputs are 
disconnected from the recording electrodes and connected to ground. 

 

Digital Grounds 

Shutoff Signal 
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4. EPS Client Server 
 
The Electrode Positioning (EPS) Client is connected to the Electrode Positioning 
Server. The features of the client are as the features of the server except for the HW 
configuration settings. 

Available client features: 

 Independent electrodes position manipulation. 

 Group/all electrodes positioning. 

 Resetting motors. (It is recommended to do at the server because motor reset is 
performed at the beginning of the experiment.) 

 Speed control. 

 Error histograms. 

4.1 Running the EPS Client 
To run the EPS Client application 

 In the EPS client computer desktop, click EPS client icon. 

OR 

 Select Start > Program > EPS client. 

Once the EPS Client is running, verify at the status bar that it is automatically 
connected to the server. 

The status bar may indicate either of the following: 

 Disconnected 

 Working 

 

 

If the client is disconnected do, the following: 

1. In the server, select Options->TCP Server Options. 

The following window appears: 
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2. Verify that the under Status appears listen... in Connection 1. 
If not, click Start. 

3. In the client select Options > TCP options. 

The following window opens: 

 

4. Under IP Address (of connection1), enter the IP address of the server 
as it appears at the bottom of the TCP Server Options window. 

5. To establish connection, click Start. 

6. Under Status, view the client connection status. 

7. To get the server settings, select Options > Initialize > Refresh. 

 

 
 
 
 

4.2 Defining a Workspace 
 

Following is an example of a workspace that would be used for EPs client server 
apploication for two users. One user works on the server and the second works on 

Server IP 
address 
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the client, when each one controls two of the four motors wothout disturbing the each 
other. 

To define the workspace do the following: 

1. Select Options > Initialize. 

The Initialize window opens: 

 

2. Under On, select the motors you wish to enable. In this training session 
select the first motor. 

3. To view the electrode properties, click Properties. 

The Electrode Properties window opens: 

 

Now, you will do the following: 

 Move the first two motors into a group called Elec1-2. 

 Move the last two motors into a group called Elec 3-4 

 Name the electrodes elec1 – elec4. 
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1. In Name box, type elec1. 

2. In Group box, type Elec 1-2 for motors 1 & 2 and Elec 3-4 for motors 
3&4. 

 Note: You may also change the range and the slack. The maximum 
range value is 40. Currently, leave the default. 

 

3. Repeat steps 1 and 2 for the rest of the electrodes. 

4. Click Ok to apply changes and to close the window. 

5. In the warning click Yes and wait until reset is complete. 

 Note: If any problem occurs while resetting the motors, an error 
message appears indicating the problem, with the motor number. 

 

The main window with the new definitions appears. 

1. In the EPS Client select File > Get Server Settings. 

2. Verify that the EPS Client restarts with the same settings as the server. 

 

3. In the client, close the Elec1-2 Group. 

4. Click Save, to save the workspace. 

5. In the server, close the Elec3-4 Group. 

Each user may work without distracting the other user. 
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Appendix A: Flexible Shaft 
Placement 
Flexible Shafts Assembly Instruction: 

1. Remove the cover of the EPS box, by unscrewing the four screws marked by 
blue circles.  Use an appropriate screwdriver (type of screw: M2x5). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



EPS GII User’s Manual                              Version 4.12                                28 

 
 

2. Bring the flexible shaft to working area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. For clarification purposes, we’ll divide the flexible shaft to three areas, as follows: 
 Part1:  peek (polyetheretherketone) tubing, placed in the middle side 

of the flexible shaft. 
 Part2:  shaft & short stainless steel tubing, placed in the right side of 

the flexible shaft (connects to the MT side). 
 Part3:  long stainless steel tubing, placed in the left side of the flexible 

shaft (connects to the EPS side). 
4. Refer to part 2 of the flexible shaft assembly. 
5. Make sure that the shaft protrudes out of the short stainless steel tubing. The 

protrusion distance “L” is 6-7 [mm]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Part 3

Part 1 Part 2

L 

Short s.s. 
Tubing

Shaft 

Peek Tubing 



EPS GII User’s Manual                              Version 4.12                                29 

 
6. Choose the port you want to use, and then insert the flexible shaft assembly 

in. say we want to use port #3, thus we need to insert the flexible shaft 
assembly in port #3. To do that, we need to perform the following steps: 
 Unscrew the port plate, use appropriate screwdriver (M2x8). 
 Unscrew the shaft plate, use appropriate screwdriver (M2x8). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 Insert the flexible shaft assembly inside the EPS box, through the port plate, 

ended in the shaft’s plate, as seen in the following pictures. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Port 1 

Port 2 

Port 3 

Port 4 

Shaft’s Plate 
Port Plate 

Flexible shaft is 
inserted in the EPS 

box thru the port 
plate. 

EPS Box 

EPS 
Box 

Port Plate 
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7. Verify that the shaft does not pass through the groove of the lower shafts 
plate (gold color plate), as shown. 

8. Lock the shaft plate on the shaft, by screwing the two screws on the shaft 
plate, as seen. Use appropriate screwdriver, type of screw: M2x8. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ends in the Shaft’s 
plate. 

Shaft’s Plate 

Lower Shaft Plate 
(gold color) 

Shaft 

Shaft’s Plate 

Groove of the 
Lower Plate 
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9. Verify that the right end of the long stainless steel tubing will be placed about 
0.5[mm] away from the edge of the perpendicular beam, as shown. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Perpendicular Beam 

Right end of the 
Long Stainless Steel 

Tubing 

0.5 [mm] 

Edge of 
Perpendicular  

Beam
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10. Lock the Port Plate on the Peek Tubing (it’s very important to do the 

locking process on the Peek Tubing), by screwing the two screws of the 
Port Plate, as shown. Use appropriate screwdriver. Type of screws: M2x8. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Verify you repeat all steps from 1 to 9, to every flexible shaft you need to 
assemble to the EPS BOX. 

12. Steps 1-10 will end the assembly instructions of the flexible shafts to the EPS 
BOX. 

 
 

Flexible Shafts Positioning Shape Affect on Slack 
Due to their flexibility, after they are connected on both ends, Flexible Shafts affect 
the amount of slack in the movement whenever the direction of movement is 
changed.  When such a slack exists the electrode will not move when movement 
direction is changed until the slack is covered. 
 
Minimum slack – 0 microns 
Typical slack – 20 microns 
Maximum slack – 50 microns 

EPS Box 

Port Plate 

Screwdriver 

Flexible Shaft Peek 
Tubing M2x8 Screws 
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Appendix B: MT Microdriving 
Terminal 
Introduction 
MT Major Components 

 The MT is assembled of 4 major parts (see Figure B-1): 
1. XY Manipulator Table  
2. Tubing holder  
3. Z-Scale tower  
4. Guiding Box (in some MT’s) 

 

Assembly procedure  
WARNINGS 

1. Extra care should be taken when tightening the MT screws.  Screws that 
are over-tightened may cause irreversible damage to the drive or to the 
shafts.  Special caution should be taken with the U0-7 and L0-7 screws 
(see Figure B-1).  

2. After using the MT it should be stored with special care.  Slide the 
electrodes up and down on a daily basis in order to prevent dirt from 
causing the electrodes to get stuck in the polyamide tubing. 
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Figure B-1: Micro driving Terminal

Z-Scale Tower 

 
Guiding Box

XY 
Manipulator 

Tubing 
holder

Headstage 
output pins 

U 0-7 

Shaft 
screws 

L 0-7 

Electrode 
screws 

Headstage 
Placement 
holes
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Figure B-2: MT parts and screws 

 

 

 

 

General Description 
The MT - Micro-driving Terminal (shown in Figure B-1) is used to maneuver up to 32 
Microelectrodes using the EPS-Electrode Positioning System.  The EPS is coupled to 
the microelectrodes with flexible shafts (see Figure B-2) that allow the electrodes to 

1

6 

G 
screw 

9 

13

1. Microelectrodes 
2. XY Manipulation Screws 
3. XY Manipulator Table  
    (1.5” width and 2.1” length) 
4. Stainless Steel Guide Tube 
5. Electrode Tubes 
6. Guiding Box  
7. Guiding box rod 
8. Head Stage fixation screw 

holes 
9. Guiding shafts 
10. Tubing holder  
11. Z direction adjustment screw 
12. Flexible Shaft 
13. EPS 

2 

3

4

5 

10 

 12

8 

A, A 
screws 

L 0-7 
screws 
 

U 0-7 
screw

B screw

11

12

7
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be moved simultaneously or independently, manually or mechanically (using the 
EPS). 
 

Main Features 
The MT can handle up to 32 Microelectrodes.  
The minimum distance between electrodes is 400 to 500 microns.  
The MT allows vertical adjustment for initial position with range of 40 mm, and then 
allows vertical working range of 40 mm. 
Each Microelectrode can be positioned independently with remote control.  The 
positioning is controlled by the EPS. 
The XY Manipulator Table allows a 16 mm movement in each direction.  (Maybe less 
based on the layout of the electrodes) 
The MT is connected to the EPS with Flexible Shafts so that the movements of the 
animal’s head will not change the position of the Microelectrodes (the movements will 
be absorbed by the Flexible Shafts). 
The MT’s small dimensions make it possible to use two MTs to record from two 
different areas of the brain. 
Special Configurations:  

Standard electrodes can be used.  The length of the microelectrodes should be 
calculated according to the specifications of the experiment and the recording 
chamber. 
The Stainless Steel Guide Tube can be supplied in a variety of lengths.  
The inner diameter can be supplied in wide variety of diameters to fit the electrode 
size and number. 
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Cautions 
Both the electrodes and the Shafts are extremely delicate.  As a result, improper use 
can cause damage to these very important parts of your system.  The screws 
should be handled with care, closing them too tight will cause damage to the 
components. 
The three main dangers are: inadvertent pushing of the electrodes forward, driving 
the motors against infinite load and accidentally applying backpressure to the motors.  
To prevent these kinds of accidents, it is important to be constantly aware of the 
state of the screws on the MT, and to couple and decouple the electrodes with 
extreme care. 
If the screws holding the electrodes in place (L0-7) are not tightly closed when the 
electrodes are connected to the flexible shafts, the electrodes will slide forward into 
or onto whatever is at the end of the MT. 

If the screws holding the electrodes in place (L0-7) are not released when the 
electrodes are driven with the stepper motors, the motor will be pushing against an 
infinite load and could be damaged. 

If the screws holding the flexible shafts in place (U0-7) are closed onto the inner shaft 
of the flexible shaft, it will be prevented from moving, and again the motor will be 
pushing against infinite load.  It is important to make sure that the upper screws close 
onto the external metal sleeve and not onto the shaft itself. 

If, when the shafts are connected to the electrodes, one is not careful to hold the 
shaft on the inner shaft itself (and not on the metal sleeve), the shaft will be pushed 
back towards the motor.  

For proper operation of the electrodes, make sure that the electrodes are always free 
of dirt after use.  When not in use you should move the electrodes at least once a 
day. 
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Preparing the MT for use 
The MT is supplied assembled.  In order to place the electrodes and the flexible 
shafts in place the following actions need to be taken: 

Electrode Placement (refer to Figures B-1 and B-2 for screws 
location) 
Loading the electrodes into the stainless steel guide can be accomplished in two 
ways: 

Front Load 

 Separate the Z Scale Tower from the XY Manipulator Table by releasing the 
B screw using a standard M2 Allen Wrench. 

 Carefully insert the electrodes into the Electrode Tubes.  Do not bend the 
electrodes or damage their tips.   

 Slide the electrodes down the Stainless Steel Guide to the point where they 
will reach the tip of the Guide. 

 Release the L0-7 screws, then release the Electrode screws using the 
provided Mini Hex Wrench (0.028”).  The Electrode screws must be released 
with extreme care - due to their miniature size they might get lost. 

 Insert the upper end of the electrodes to the Flexible Shaft Terminals. 

 Tighten the Electrode screws and the L0-7 screws.      

  Back Load 

Back load is recommended only if the diameter of the upper end of the 
electrode is the same as the diameter of the body of the electrode.  In any 
case back load should be done with extra care so that neither the tip nor the 
glass coating of the electrode will get damaged.  

 Insert the upper end of the electrodes through the Stainless Steel 
Guide and slide them into the point where they are inside the guide.  

 Maneuver each electrode into the Electrode Tubes. 

 Follow the three last steps of Front Load.    

 

Flexible Shafts placement into the MT 

 
Before you connect the flexible shafts to the MT, make sure they are connected to 
the EPS and the EPS motor box is sitting or fixed to the experiment frame.  The 
Flexible shafts should be connected to the MT after the MT has already been 
installed on the recording chamber on the animal’s head.  To attach the flexible 
shafts to the MT follow these steps:  

 Release both the U0-7 screws and the Guiding Shafts upper screws 
(again, handle the miniature screws with care).     

 Insert the internal tip of the Flexible Shafts into the holes in the upper 
side of the Tubing Holder and inside the Guiding shafts. 

 Once the Flexible Shafts are in place Tighten the Flexible Shaft screws 
to lock them in place. 
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 Lower the metal sleeve of the Flexible Shaft till it goes inside the hole 
at the top of the Tubing Holder. 

 Tighten the U0-7 screw to lock the metal sleeve in place. 

 

Electrode and Guide Movements 
The following movements can be accomplished using different settings of the screws: 

1. Guide only (no movement of electrodes) – Only in MT’s with a guiding box 

2. Guide with all electrodes – Only in MT’s with a guiding box 

3. All electrodes  

4. Single electrode 

Guide Only (no movement of electrodes) 

This configuration is rarely used, although one could imagine it being used to draw 
the guide back, away from electrodes of which relative positions need to remain fixed 
(say, for purpose of measuring relative depth).  By closing the L0-7 screws, the 
electrodes are fixed in place.   

Following, open both the A screws, separating the guide from the Z screw, and the G 
screw – decoupling the guide from the X-Y positioner.  Now the guide is completely 
free to move, and can be positioned by hand.  A disadvantage of using this method is 
that free movement will prevent accurate positioning of the guide. 

Guide with all electrodes 

This configuration is used in order to advance the guide and electrodes together into 
the brain.  This is done in order to reach deep structures in the brain.  By advancing 
the electrodes within the guide, one ensures that they will travel in a straight line, and 
not splay or bend, as bare microelectrodes tend to do within the brain.  In order to 
achieve this type of movement, the U0-7 and L0-7 screws are closed, fixing the 
electrodes to the Z screw, and the AA screws are closed, fixing the guide also to the 
Z screw.  Now, as the Z screw is advanced, both guide and electrodes will move 
together.  The G screw must be open in order to allow the guide to move freely in the 
X-Y positioner. 

All Electrodes (guide is fixed if exists) 

This configuration is used to advance the electrodes out from the guide and into the 
brain.  Advancing in this manner ensures that electrodes that have been aligned 
relative to one another remain aligned.  Also, movement in this manner extends the 
reach of the device, since it does not come at the expense of movement with the 
EPS.  In order to advance in this manner, the L0-7 screws must be closed – locking 
the electrodes to the Z screw – and the AA screws must be open – so that movement 
of the Z screw does not move the guide.  The G screw must be closed in order to 
prevent the guide from slipping.  Now movement of the Z screw will drive all of the 
electrodes without moving the guide. 

Single Electrode 

To allow individual electrodes to be moved with the Micro drive, it is necessary to 
disconnect them from the Z screw.  Opening the lower screws (L0-7) does this.  The 
upper screws (U0-7) must be closed.  Otherwise the motors will flex the flexible 
shafts rather than driving the electrodes. 
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Electrode and Guide movement summary table: 
 

Screws
Movement 

U0-7 L0-7 A, A G Mover 

Guide Only Locked Locked Opened Opened Manual 

Guide with all 
electrodes 

Locked Locked Locked Opened Z Screw 

All electrodes 
(Guide Fixed) 

Locked Locked Opened Locked Z Screw 

Single 
electrode 

Locked Opened Locked Locked EPS 
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Recording Procedures 
General Recording Procedures 

- Adjust the guide so that it is not longer than the chamber depth.  
Otherwise, attaching the MT to the chamber will cause damage to 
the brain. 

- Set the X-Y positioner to the desired recording position. 

- Attach the MT to the chamber. 

- Insert flexible shafts – see instructions above 

- Advance guide with electrodes together to appropriate depth. 

- Advance electrodes together (guide fixed) until electrodes are 
outside of guide, and perhaps until some specific structure is 
reached. 

- Advance electrodes individually, isolating units on each electrode. 

- Record 

- Pull electrodes back together (guide fixed) until electrodes are well 
within guide. 

- Pull electrodes and guide back together until guide is well out of 
the brain. 

- Disconnect flexible shafts from the MT. 

- Remove MT terminal from chamber. 

- On the lab bench, advance all electrodes (guide fixed) until they 
are out of the guide.  Now, using binoculars, it is possible to 
measure the relative vertical depth of the electrodes. 
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Specific recording procedures 
 

Procedure for Cortical Recording 
1. Choose electrode lengths such that when the Z screw is at 10mm, the 

electrode tips are 1mm inside the guide.  Measure the depth of the 
chamber, and set the guide length such that the guide just barely 
touches the durra.  There will be no need to move the guide during the 
experiment. 

2. Before attaching the MT terminal to the chamber, fill the chamber with 
2% agar.  This will significantly improve the stability of recordings 

3. Move electrodes together (guide fixed) until cells appear.  Back up 1 
mm from this point.  Since the electrodes penetrating the durra 
together  can press the durra inward, backing up a little bit will 
release pressure and improve stability. 

4. Now begin moving electrodes individually and isolate units. 

5. Record. 

6. Back up all electrodes (guide fixed) until they are well within the guide.  
Remember that this means backing up by at least the sum of how 
much the electrodes were advanced together in step 3 and how much 
each of them was advanced individually in step 4.  It is probably best 
to back up 4 or 5 mm more than this, to make sure that the electrodes 
are within the guide. 

7. Disconnect the flexible shafts from the electrodes and remove the MT 
terminal from the chamber.  Measure relative depths. 

GP Recording in Cats 
Our Instrument distances: 

Vertical distance from the upper border of the center to the dura - 

            15 degree chambers at 0,0-22 mm 
Vertical distance from tip of needle to caption (regular 14g bevel) -6 mm. 

Stereotaxic Coordination 
Stereotaxic Coorditations are taken from Snider, R.S. and Niemer, W.T. A 
STEREOTAXIC ATLAS OF THE CAT BRAIN. Chicago, Illinois: The University of 
Chicago Press, 1961. 

- A-P range of Globus Pallidus:  A15.0 - A9.0 

- A-P range of Nuc. Entopeduncularis: A13.5 - A10.0 

- In A12.0 The medio-lateral range of GP is from L9 to L10.5 

  The Vertical range is H0.5 - H2.5 
  The upper limit of cortex at A12.0 is about H18.0 
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Chamber Position - Vertical Approach 
Center of the chamber is located vertically at A12.0, L10.0. 

Guide position X=0, Y=0, or X=-1, Y=0 (more lateral penetration will take us to 
putamen). 

Vertical distance from durra to upper border of GP is about 15mm. 

 

Procedure for GP Recording in Cats 
1. Insert all electrodes in a way that the Z screw is at 5-mm from top 

(back spare distance). Electrode tips will be 1mm inside the caption 
tubes. 
All electrodes are 10 - 50 m below “upper limit” of EPS, after taking 
the slack in down direction. 
All screws except -7 are locked. 

2. Put the chamber on the durra and measure the distance from the top 
of the chamber to the surface of the durra in penetration coordination. 
Don’t put agar. 

3. Put the drive on the chamber, insert the flexible shafts through U0-7 
and connect them to the electrode holders. Lock U0-7. 

4. Turn on MCP8, and measure impedance. 

5. Open G and move all electrodes with the guide till they touch the 
durra. Move further (9mm) till 6mm above target. 
Lock G when done. 

6. Open AA and move all electrodes (with the guide fixed) another 4mm 
(all distance). (Keep in mind that the tips of the electrodes are now -3 
mm from the tip of the guide!) Lock AA when done. 

7. Open L0-7, and start moving with single electrodes till you get at least 
three (+/-) well-isolated units in each of electrodes. 

8. Record. 

9. Lock L0-7; disengage (with small forceps) the flexible shaft from the 
electrode holder. Open U0-7 and remove the flexible shaft. 

10. Mark the location of the tips of the microelectrodes with 17.5A, 15 
second cathodal (electrode tip negative) current. 

11. Open AA, take all electrodes out with the Z back to the captions  
(e.g. the all distance) (See #6; 4mm) plus the back spare distance  
(see #1; 5mm).   
Lock AA when done. 
Open G; move back with the guide and the electrode up to 0mm from 
top.  Lock G when done. 
Release the drive from the chamber (Warning: electrodes that were 
more than 5mm might be out of the captions). 
Cover the chamber. 

12. Perfuse the animal. 

13. Open AA, Push all the electrodes (with the Z screw) until they are out 
of the guide, and measure under binocular the relative vertical depth of 
each electrode. 

14. Write the paper! 
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Procedure for GP recording in monkey (vertical approach) 
GP distance from the dura (A12, L6-24mm, L10-18mm, but at L6 GP is longer, 
therefore we assume that the upper border of GP is 20mm below dura. 
 
1. Insert all electrodes, in a way that the Z screw is at 3mm from top (back spare 

distance=3), the electrodes are 10 -50 m below “upper limit” of EPS, after 
pulling the slack downwards.  

2. Put the drive on the chamber, insert the flexible shafts through U0-7 and 
connect them to the electrode holders. 

3. Turn on MCP8, and measure impedance. 

4. Open G and move all electrodes with the guide, till they touch the durra. Move 
further 18mm till they reach 2mm above the upper border of GP. 
Lock G when done. 

5. Open AA and move all electrodes (with the guide fixed) another 3mm (all 
distances=3) Lock AA when done. 

6. Open L0-7, and make a continuous move of 1mm, with each electrode. Make 
sure that all electrodes are moving. 
 
If everything is OK, the electrodes are now 1 mm below the tip of the guide 
and 1 mm above the upper border of GP. 

7. Move with single electrodes till you get at least one well-isolated unit in each 
of the electrodes. 

8. Record. 

9. Lock L0-7; disengage (with small forceps) the flexible shaft from the electrode 
holder. Open U0-7 and remove the flexible shaft. 

10. Optional: Mark the location of the tips of the microelectrodes with 17.5A, 15 
second cathodal (electrode tip negative) current. 

11. Open AA, take all electrodes out with the Z back to the captions (e.g. the 
whole distance)(see #5; 3 mm) plus the back spare distance (see #1; 3 mm). 
Lock AA when done. 

12. Open G; Move back with the guide and electrode up to 0 mm from top. 
Lock G when done. 
Release the drive from the chamber (Warning: electrodes that were moved 
more than 3 mm might be out of the captions). 

 Flush and cover the chamber. 

13. Backup data. 

14.  Open AA, Push all the electrodes (with the Z screw) until out of the guide, and 
measure with binoculars the relative vertical depth of each electrode. 
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The Double MT  
General  
The Double MT (see figures 3 and 4) introduces a sophisticated solution for the 
researcher who wishes to investigate and record from two areas of a chamber 
simultaneously.  This appendix provides information on how to configure the Double 
MT in various angles. 

 

Figure B-3: Double MT front side   

 

 

Figure B-4: Double MT angle setup 
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Angle Configuration  
  

 

Figure B-5: Close up on angle configuration screws 

 

 

* To understand the description below refer to figure 3 – front side view of the Double 
MT.  

The two Z-Scale Bars (Towers) can change posture in two directions while being 
fixed to the XY-Manipulator Table.  They can be moved backwards and forward and 
they can be spread to the left and right sides. 

Backward – Forward movement 

Using a 1.5 mm Allen screw driver untighten both D screws and the T screw.     

Left – Right movement  

Using a 1.5 mm Allen screw driver untighten both S screws and both F screws.   

Moving the Z-Scale Bars on the base XY table (left – right only) 

Using a 1.5 mm Allen screw driver untighten the Q screw. 

Moving the Z-Scale Bars on the upper XY scale (backward - forward only) 

Using a 1.5 mm Allen screw driver untighten the T screw and move the Z-Scale Bar 
forward or backward to allow a 2.5 mm Allen screw driver placement in the R screw 
hole.  Untighten the R screw and move the position the Z-Scale Bar to desired 
location. 
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